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Welcome

This is the Amazon Route 53 API Reference. Amazon Route 53 is a web service that enables you to
manage your DNS service.

This API Reference contains descriptions of the following actions and elements.

• Actions on Hosted Zones (p. 2)

• Actions on Resource Records Sets (p. 21)

• Common Headers (p. 38)

For a guide to using Amazon Route 53, see the Amazon Route 53 Developer Guide.
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Actions on Hosted Zones

Topics

• POST CreateHostedZone (p. 3)

• GET GetHostedZone (p. 9)

• DELETE DeleteHostedZone (p. 13)

• GET ListHostedZones (p. 16)

This section describes actions you can perform on hosted zones.

For more information, see About Hosted Zones in the Amazon Route 53 Developer Guide.
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POST CreateHostedZone

Description
This action creates a new hosted zone.

To create a new hosted zone, send a POST request to the 2010-10-01/hostedzone resource. The
request body must include an XML document with a CreateHostedZoneRequest element.The response
returns the CreateHostedZoneResponse element that contains metadata about the hosted zone.

Important

You cannot create a hosted zone for a top-level domain (TLD).

Amazon Route 53 automatically creates a default SOA record and four NS records for the zone. The NS
records in the hosted zone are the name servers you give your registrar to delegate your domain to. For
more information about SOA and NS records, see Appendix A: Domain Name and Resource Record
Formats in the Amazon Route 53 Developer Guide.

When you create a zone, its initial status is PENDING. This means that it is not yet available on all DNS
servers. The status of the zone changes to INSYNC when the NS and SOA records are available on all
Amazon Route 53 DNS servers. For more information on creating hosted zones, see Creating a New
Virtual DNS Service in the Amazon Route 53 Developer Guide.

Requests

Syntax

POST /2010-10-01/hostedzone HTTP/1.1
<?xml version="1.0" encoding="UTF-8"?>
<CreateHostedZoneRequest xmlns="https://route53.amazonaws.com/doc/
2010-10-01/">
   <Name>example.com.</Name>
   <CallerReference>myUniqueIdentifier</CallerReference>
   <HostedZoneConfig>
      <Comment>This is my first hosted zone.</Comment>
   </HostedZoneConfig>
</CreateHostedZoneRequest>

Headers
The request must include the headers required in all Amazon Route 53 requests. For more information,
see Common Headers (p. 38).
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Elements

RequiredDescriptionName

YesA complex type containing the hosted zone request
information.

Type: Complex

Default: None

Children: Name, CallerReference,
HostedZoneConfig

CreateHostedZoneRequest

YesThe name of the domain.This must be a fully-specified
domain that ends with a period as the last label
indication. If you omit the final period, Amazon Route
53 assumes the domain is relative to the root. This is
the name you have registered with your DNS registrar.
You should ask your registrar to set the authoritative
name servers for your domain so they are the same as
the set of NameServers returned in DelegationSet.

Type: String

Default: None

Name

YesA unique string that identifies the request and that
allows failed CreateHostedZone requests to be retried
without the risk of executing the operation twice.You
must use a unique CallerReference string every
time you create a hosted zone. CallerReference can
be any unique string; you might choose to use a string
that identifies your project, such as
MyDNSMigration_01.

Type: String

Default: None

Constraints: Allowable characters are any Unicode
code points that are legal in an XML 1.0 document.The
UTF-8 encoding of the value must be less than 128
bytes.

CallerReference

NoA complex type that contains configuration information
for your hosted zone.

Type: Complex

Default: None

Children: Comment

HostedZoneConfig

NoAny comments you want to include about the hosted
zone.

Type: String

Default: None

Constraints: Maximum 256 characters

Parent: HostedZoneConfig

Comment

API Version 2010-10-01
4

Amazon Route 53 API Reference
Requests



Responses

Syntax

HTTP/1.1 201 Created
<?xml version="1.0" encoding="UTF-8"?>
<CreateHostedZoneResponse xmlns="https://route53.amazonaws.com/
doc/2010-10-01/">
   <HostedZone>
      <Id>/hostedzone/Z1PA6795UKMFR9</Id>
      <Name>example.com.</Name>
      <CallerReference>myUniqueIdentifier</CallerReference>
      <Config>
         <Comment>This is my first hosted zone.</Comment>
      </Config>
   </HostedZone>
   <ChangeInfo>
      <Id>/change/C1PA6795UKMFR9</Id>
      <Status>PENDING</Status>
      <SubmittedAt>2010-09-10T01:36:41.958Z</SubmittedAt>
   </ChangeInfo>
   <DelegationSet>
      <NameServers>
         <NameServer>ns-01.awsdns-00.com</NameServer>
         <NameServer>ns-500.awsdns-11.net</NameServer>
         <NameServer>ns-1112.awsdns-31.org</NameServer>
         <NameServer>ns-1600.awsdns-27.co.uk</NameServer>
      </NameServers>
   </DelegationSet>
</CreateHostedZoneResponse>

Headers
The response will include the headers in all Amazon Route 53 responses. For more information, see
Common Headers (p. 38).

Elements

DescriptionName

A complex type containing the response information for the hosted zone.

Type: Complex

Children: HostedZone, ChangeInfo, DelegationSet

CreateHostedZoneResponse

A complex type containing the specific identifying information about the
hosted zone.

Type: Complex

Children: Id, Name, CallerReference, Config

HostedZone

The ID of the hosted zone.

Type: String

Parent: HostedZone

Id
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DescriptionName

The name of the domain. This must be a fully-specified domain, ending
with a period as the last label indication. If you omit the final period,
Amazon Route 53 assumes the domain is relative to the root.

This is the name you have registered with your DNS registrar. It is also
the name you delegate from your registrar to the Amazon Route 53
delegation servers returned in response to this request.

Type: String

Parent: HostedZone

Name

A unique string that identifies the request to create the hosted zone.

Type: String

Parent: HostedZone

CallerReference

A complex type that includes the Comment element.

Type: Complex

Parent: HostedZone

Children: Comment

Config

The comment included in the CreateHostedZoneRequest element.

Type: String

Constraints: Maximum 256 characters

Parent: Config

Comment

A complex type that describes change information about changes made
to your hosted zone.

This element contains an ID that you use when performing a GetChange
action to get detailed information about the change.

Type: Complex

Children: Id, Status, SubmittedAt

ChangeInfo

The ID of the request. Use this ID to track when the change has
completed across all Amazon Route 53 DNS servers.

Type: String

Parent: ChangeInfo

Id

The current state of the hosted zone.PENDING indicates that this request
has not yet been applied to all Amazon Route 53 DNS servers.

Type: String

Valid Values: PENDING | INSYNC

Parent: ChangeInfo

Status

The date and time the change was made.

Type: String with date in the format YYYY-MM-DDThh:mm:ssZ, as
specified in the ISO 8601 standard (for example, 2009-11-19T19:37:58Z)

Parent: ChangeInfo

SubmittedAt

A complex type that describes name server information.

Type: Complex

Children: NameServers

DelegationSet
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DescriptionName

A complex type that identifies the authoritative name servers for the
hosted zone.You ask your registrar to add an NS record to your domain
for each NameServer assigned to your hosted zone.

Type: Complex

Parent: DelegationSet

Children: NameServer

NameServers

Identifies a name server that is authoritative for your domain.

Type: String

Parent: NameServers

NameServer

Note

In the context of CreateHostedZone, the ChangeInfo element indicates the creation of the
SOA records and records for the NameServer names.

Errors
The following table lists the errors returned for this action.

DescriptionName

Amazon Route 53 allows some duplication, but Amazon Route 53 has
a maximum threshold of duplicated domains. This error is generated
when you reach that threshold. In this case, the error indicates that too
many hosted zones with the given domain name exist. If you want to
create a hosted zone and Amazon Route 53 generates this error, contact
Customer Support.

DelegationSetNotAvailable

The specified domain name is not valid.InvalidDomainName

The hosted zone you are attempting to create already exists.

Amazon Route 53 returns this error when a hosted zone has already
been created with the supplied CallerReference.

HostedZoneAlreadyExists

This hosted zone cannot be created. The hosted zone limit has been
exceeded. To request a limit increase, contact Customer Support.

TooManyHostedZones

The input is not valid.InvalidInput

Examples

Example Request

POST /2010-10-01/hostedzone HTTP/1.1
<?xml version="1.0" encoding="UTF-8"?>
<CreateHostedZoneRequest xmlns="https://route53.amazonaws.com/doc/2010-10-01/">
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   <Name>example.com.</Name>
   <CallerReference>myUniqueIdentifier</CallerReference>
   <HostedZoneConfig>
      <Comment>This is my first hosted zone.</Comment>
   </HostedZoneConfig>
</CreateHostedZoneRequest>

Example Response

HTTP/1.1 201 Created
<?xml version="1.0" encoding="UTF-8"?>
<CreateHostedZoneResponse xmlns="https://route53.amazonaws.com/doc/2010-10-01/">

   <HostedZone>
      <Id>/hostedzone/Z1PA6795UKMFR9</Id>
      <Name>example.com.</Name>
      <CallerReference>myUniqueIdentifier</CallerReference>
      <Config>
         <Comment>This is my first hosted zone.</Comment>
      </Config>
   </HostedZone>
   <ChangeInfo>
      <Id>/change/C1PA6795UKMFR9</Id>
      <Status>PENDING</Status>
      <SubmittedAt>2010-09-10T01:36:41.958Z</SubmittedAt>
   </ChangeInfo>
   <DelegationSet>
      <NameServers>
         <NameServer>ns-01.awsdns-00.com</NameServer>
         <NameServer>ns-500.awsdns-11.net</NameServer>
         <NameServer>ns-1112.awsdns-31.org</NameServer>
         <NameServer>ns-1600.awsdns-27.co.uk</NameServer>
      </NameServers>
   </DelegationSet>
</CreateHostedZoneResponse>
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GET GetHostedZone

Description
To retrieve information about a hosted zone, send a GET request to the
2010-10-01/hostedzone/<hosted zone ID> resource.

For more information about using this action to get name server information, see Retrieving Your Name
Servers in the Amazon Route 53 Developer Guide.

Requests

Syntax

GET /2010-10-01/hostedzone/Z1PA6795UKMFR9

Headers
The request must include the headers required in all Amazon Route 53 requests. For more information,
see Common Headers (p. 38).

Parameters
The request must contain the hosted zone ID. Amazon Route 53 returns the hosted zone ID in the
HostedZone element as part of the CreateHostedZoneResponse or ListHostedZonesResponse.
For more information, see POST CreateHostedZone (p. 3) or GET ListHostedZones (p. 16).

Responses

Syntax

HTTP/1.1 200 OK
<?xml version="1.0" encoding="UTF-8"?>
<GetHostedZoneResponse xmlns="https://route53.amazonaws.com/doc/2010-10-01/">
   <HostedZone>
      <Id>/hostedzone/Z1PA6795UKMFR9</Id>
      <Name>example.com.</Name>
      <CallerReference>myUniqueIdentifier</CallerReference>
      <Config>
         <Comment>This is my first hosted zone.</Comment>
      </Config>
   </HostedZone>
   <DelegationSet>
      <NameServers>
         <NameServer>ns-01.awsdns-00.com</NameServer>
         <NameServer>ns-500.awsdns-11.net</NameServer>
         <NameServer>ns-1112.awsdns-31.org</NameServer>
         <NameServer>ns-1600.awsdns-27.co.uk</NameServer>
      </NameServers>
   </DelegationSet>
</GetHostedZoneResponse>
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Headers
The response will include the headers in all Amazon Route 53 responses. For more information, see
Common Headers (p. 38).

Elements

DescriptionName

A complex type containing information about a hosted zone.

Type: Complex

Children: HostedZone, DelegationSet

GetHostedZoneResponse

A complex type containing the specific identifying information about the
hosted zone.

Type: Complex

Children: Id, Name, CallerReference, Config

HostedZone

The ID of the hosted zone.

Type: String

Parent: HostedZone

Id

The name of the domain. This must be a fully-specified domain, ending
with a period as the last label indication. If you omit the final period,
Amazon Route 53 assumes the domain is relative to the root.

This is the name you have registered with your DNS registrar. It is also
the name you delegate from your registrar to the Amazon Route 53
delegation servers returned in response to this request.

Type: String

Parent: HostedZone

Name

A unique string that identifies the request to create the hosted zone.

Type: String

Parent: HostedZone

CallerReference

A complex type that includes the Comment element.

Type: Complex

Parent: HostedZone

Children: Comment

Config

The comment included in the CreateHostedZoneRequest element.

Type: String

Constraints: Maximum 256 characters

Parent: Config

Comment

A complex type that describes name server information.

Type: Complex

Children: NameServers

DelegationSet
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DescriptionName

A complex type that identifies the authoritative name servers for the
hosted zone.You ask your registrar to add an NS record to your domain
for each NameServer assigned to your hosted zone.

Type: Complex

Parent: DelegationSet

Children: NameServer

NameServers

Identifies a name server that is authoritative for your domain.

Type: String

Parent: NameServers

NameServer

Errors
This action returns the following error.

DescriptionName

The input is not valid.InvalidInput

Examples

Example Request
The following shows a GET request for information about a hosted zone with an ID of Z1PA6795UKMFR9.

GET /2010-10-01/hostedzone/Z1PA6795UKMFR9

Example Response
The following shows the response to the GET request.

HTTP/1.1 200 OK
<?xml version="1.0" encoding="UTF-8"?>
<GetHostedZoneResponse xmlns="https://route53.amazonaws.com/doc/2010-10-01/">
   <HostedZone>
      <Id>/hostedzone/Z1PA6795UKMFR9</Id>
      <Name>example.com.</Name>
      <CallerReference>myUniqueIdentifier</CallerReference>
      <Config>
         <Comment>This is my first hosted zone.</Comment>
      </Config>
      </HostedZone>
      <DelegationSet>
         <NameServers>
            <NameServer>ns-01.awsdns-00.com</NameServer>
            <NameServer>ns-500.awsdns-11.net</NameServer>
            <NameServer>ns-1112.awsdns-31.org</NameServer>
            <NameServer>ns-1600.awsdns-27.co.uk</NameServer> 
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         </NameServers>
      </DelegationSet>
      </GetHostedZoneResponse>
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DELETE DeleteHostedZone

Description
This action deletes a hosted zone. To delete a hosted zone, send a DELETE request to the
2010-10-01/hostedzone/<hosted zone ID> resource.

For more information about deleting a hosted zone, see Deleting a Hosted Zone in the Amazon Route
53 Developer Guide.

Important

You can delete a hosted zone only if there is no resource record set other than the default SOA
record and NS records. If your hosted zone contains resource records other than the default
SOA record and NS records, you must delete those resource records before you can delete your
hosted zone. Any records you added to the hosted zone must be deleted first. If you try to delete
a hosted zone that contains resource records other than the default records, Amazon Route 53
will deny your request with a HostedZoneNotEmpty error. For information about deleting records
from your hosted zone, see POST ChangeResourceRecordSets (p. 22).

Requests

Syntax

DELETE /2010-10-01/hostedzone/Z1PA6795UKMFR9

Headers
The request must include the headers required in all Amazon Route 53 requests. For more information,
see Common Headers (p. 38).

Parameters
The request must contain the hosted zone ID. Amazon Route 53 returns the hosted zone ID in the
HostedZone element as part of the CreateHostedZoneResponse or ListHostedZonesResponse.
For more information, see POST CreateHostedZone (p. 3) or GET ListHostedZones (p. 16).

Responses

Syntax

HTTP/1.1 200 OK
<?xml version="1.0" encoding="UTF-8"?>
<DeleteHostedZoneResponse xmlns="https://route53.amazonaws.com/doc/2010-10-01/">

   <ChangeInfo>
      <Id>/change/C1PA6795UKMFR9</Id>
      <Status>PENDING</Status>
      <SubmittedAt>2010-09-10T01:36:41.958Z</SubmittedAt>
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   </ChangeInfo>
</DeleteHostedZoneResponse>

Headers
The response will include the headers in all Amazon Route 53 responses. For more information, see
Common Headers (p. 38).

Elements

DescriptionName

A complex type containing the response information for the request.

Type: Complex

Children: ChangeInfo

DeleteHostedZoneResponse

A complex type that describes change information about changes made
to your hosted zone.

This element contains an ID that you use when performing a GetChange
action to get detailed information about the change.

Type: Complex

Children: Id, Status, SubmittedAt

ChangeInfo

The ID of the request. Use this ID to track when the change has
completed across all Amazon Route 53 DNS servers.

Type: String

Parent: ChangeInfo

Id

The current state of the hosted zone.PENDING indicates that this request
has not yet been applied to all Amazon Route 53 DNS servers.

Type: String

Valid Values: PENDING | INSYNC

Parent: ChangeInfo

Status

The date and time the change was made.

Type: String with date in the format YYYY-MM-DDThh:mm:ssZ, as
specified in the ISO 8601 standard (for example, 2009-11-19T19:37:58Z)

Parent: ChangeInfo

SubmittedAt

Errors
The server might respond to this action with any of the following errors.

DescriptionName

The hosted zone contains resource records that are not SOA or NS
records.

HostedZoneNotEmpty

The input is not valid.InvalidInput
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Examples

Example Request
The following example shows the DELETE request with the hosted zone ID (beginning with the letter Z).

DELETE /2010-10-01/hostedzone/Z1PA6795UKMFR9

Example Response
When the status of this change becomes INSYNC, your hosted zone has been removed from all Amazon
Route 53 DNS servers.

HTTP/1.1 200 OK
<?xml version="1.0" encoding="UTF-8"?>
<DeleteHostedZoneResponse xmlns="https://route53.amazonaws.com/doc/2010-10-01/">

   <ChangeInfo>
      <Id>/change/C1PA6795UKMFR9</Id>
      <Status>PENDING</Status>
      <SubmittedAt>2010-09-10T01:36:41.958Z</SubmittedAt>
   </ChangeInfo>
</DeleteHostedZoneResponse>

API Version 2010-10-01
15

Amazon Route 53 API Reference
Examples



GET ListHostedZones

Description
To retrieve a list of your hosted zones, send a GET request to the 2010-10-01/hostedzone resource.
The response to this request includes a HostedZones element with zero, one, or multiple HostedZone
child elements. By default, the list of hosted zones is displayed on a single page.You can control the
length of the page that is displayed by using the MaxItems parameter.You can use the Marker parameter
to control the hosted zone that the list begins with. For more information about listing hosted zones, see
Listing Your Hosted Zones in the Amazon Route 53 Developer Guide.

Note

Amazon Route 53 returns a maximum of 100 items. If you set MaxItems to a value greater than
100, Amazon Route 53 returns only the first 100.

Requests

Syntax

GET /2010-10-01/hostedzone?marker=Z2EUQ1WTGCTBG2&maxitems=10

Headers
The request must include the headers required in all Amazon Route 53 requests. For more information,
see Common Headers (p. 38).

Parameters

RequiredDescriptionName

NoIndicates where to begin in your list of hosted zones.The
results include hosted zones in the list that occur after
the marker.

Type: String

Default: All your hosted zones are listed from the
beginning.

Marker

NoThe maximum number of hosted zones to be included in
the response body.

Type: String

Default: 100

Constraint: maximum value is 100

MaxItems
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Responses

Syntax

HTTP/1.1 200 OK
<?xml version="1.0" encoding="UTF-8"?>
<ListHostedZonesResponse xmlns="https://route53.amazonaws.com/doc/2010-10-01/">

   <HostedZones>
      <HostedZone>
         <Id>/hostedzone/Z2EUQ1WTGCTBG2</Id>
         <Name>example2.com.</Name>
         <CallerReference>mySecondZone</CallerReference>
         <Config>
            <Comment>This is my second hosted zone.</Comment>
         </Config>
      </HostedZone>
   </HostedZones>
   <MaxItems>1</MaxItems>
   <IsTruncated>true</IsTruncated>
   <NextMarker>Z2EUQ1WTGCTBG2</NextMarker>
   </ListHostedZonesResponse>

Headers
The response will include the headers in all Amazon Route 53 responses. For more information, see
Common Headers (p. 38).

Elements

DescriptionName

A complex type containing the response information for the request.

Type: Complex

Children: Marker, HostedZones, MaxItems, IsTruncated,
NextMarker

ListHostedZoneResponse

Indicates the marker used when generating this list of hosted zones.
The results include hosted zones in the list that occur after the marker.

Type: String

Marker

The parent element to HostedZone, this element can contain zero, one,
or more HostedZone elements.

Type: Complex

Children: HostedZone

HostedZones

A complex type containing the specific identifying information about the
hosted zone.

Type: Complex

Children: Id, Name, CallerReference, Config

HostedZone
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DescriptionName

The ID of the hosted zone.

Type: String

Parent: HostedZone

Id

The name of the domain. This must be a fully-specified domain, ending
with a period as the last label indication. If you omit the final period,
Amazon Route 53 assumes the domain is relative to the root.

This is the name you have registered with your DNS registrar. It is also
the name you delegate from your registrar to the Amazon Route 53
delegation servers returned in response to this request.

Type: String

Parent: HostedZone

Name

A unique string that identifies the request to create the hosted zone.

Type: String

Parent: HostedZone

CallerReference

A complex type that includes the Comment element.

Type: Complex

Parent: HostedZone

Children: Comment

Config

The comment included in the CreateHostedZoneRequest element.

Type: String

Constraints: Maximum 256 characters

Parent: Config

Comment

The maximum number of hosted zones you requested.

Type: String

MaxItems

A flag indicating whether there are more hosted zones to be listed. If
your results were truncated, you can make a follow-up pagination request
by using the Marker request.

Type: String

Valid Values: true | false

IsTruncated

Indicates the location from which to continue listing hosted zones. If you
make a subsequent request to ListHostedZones and supply the
NextMarker value as the marker parameter, the results will include
hosted zones in the list that occur after NextMarker. This provides a
way to list all hosted zones associated with your account.

This element is present only if IsTruncated is true.

Type: String

NextMarker

Errors
This action returns the following error.
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DescriptionName

The input is not valid.InvalidInput

Examples

Example Request
The following example shows the request with the MaxItems element specified as 1.

GET /2010-10-01/hostedzone?maxitems=1

Example Response
This example shows the response for the previous example in which MaxItems is specified as 1.

HTTP/1.1 200 OK
<?xml version="1.0" encoding="UTF-8"?>
<ListHostedZonesResponse xmlns="https://route53.amazonaws.com/doc/2010-10-01/">

   <HostedZones>
      <HostedZone>
         <Id>/hostedzone/Z2EUQ1WTGCTBG2</Id>
         <Name>example2.com.</Name>
         <CallerReference>MyUniqueIdentifier2</CallerReference>
         <Config>
            <Comment>This is my second hosted zone.</Comment>
         </Config>
      </HostedZone>
   </HostedZones>
   <MaxItems>1</MaxItems>
   <IsTruncated>true</IsTruncated>
   <NextMarker>Z2EUQ1WTGCTBG2</NextMarker>
</ListHostedZonesResponse>

Example Follow-up Request
This example shows the follow-up request to the previous request with the MaxItems element specified
as 10 and the list starting with the marker set to Z2EUQ1WTGCTBG2.

GET /2010-10-01/hostedzone?marker=Z2EUQ1WTGCTBG2&maxitems=10

Example Follow-up Response
This example shows the response for the previous example.

HTTP/1.1 200 OK
<?xml version="1.0" encoding="UTF-8"?>
   <ListHostedZonesResponse xmlns="https://route53.amazonaws.com/doc/2010-10-
01/">
      <Marker>Z2EUQ1WTGCTBG2</Marker>
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      <HostedZones>
         <HostedZone>
            <Id>/hostedzone/Z3AEGXETSR30VB</Id>
            <Name>example3.com.</Name>
            <CallerReference>MyUniqueIdentifier3</CallerReference>
            <Config>
               <Comment>This is my third hosted zone.</Comment>
            </Config>
         </HostedZone>
         <HostedZone>
            <Id>/hostedzone/Z2682N5HXP0BZ4</Id>
            <Name>example.com.</Name>
            <CallerReference>MyUniqueIdentifier4</CallerReference>
            <Config>
               <Comment>This is my fourth hosted zone.</Comment>
            </Config>
         </HostedZone>
      </HostedZones>
      <MaxItems>10</MaxItems>
      <IsTruncated>false</IsTruncated>
   </ListHostedZonesResponse>
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Actions on Resource Records Sets

Topics

• POST ChangeResourceRecordSets (p. 22)

• GET ListResourceRecordSets (p. 30)

• GET GetChange (p. 36)

This section describes actions you can perform on resource record sets.

For more information, see Working with Resource Record Sets in the Amazon Route 53 Developer Guide.
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POST ChangeResourceRecordSets

Description
Use this action to create or change your authoritative DNS information. To use this action, send a POST
request to the 2010-10-01/hostedzone/<hosted Zone ID>/rrset resource. The request body
must include an XML document with a ChangeResourceRecordSetsRequest element.

Changes are a list of change items and are considered transactional. For more information on transactional
changes, see Making Changes to Your Resource Record Sets in the Amazon Route 53 Developer Guide.

Important

Due to the nature of transactional changes, you cannot delete the same resource record set
more than once in a single change batch. If you attempt to delete the same change batch more
than once, Amazon Route 53 returns an InvalidChangeBatch error.

In response to a ChangeResourceRecordSets request, your DNS data is changed on all Amazon Route
53 DNS servers. Initially, the status of a change is PENDING.This means the change has not yet propagated
to all the authoritative Amazon Route 53 DNS servers. When the change is propagated to all hosts, the
change returns a status of INSYNC.

A ChangeResourceRecordSets request cannot reference more than 1000 ResourceRecord elements.
Additionally, the count of characters contained in all RDATA fields in the ResourceRecord elements of
a ChangeResourceRecordSets request cannot exceed 32000. This limit is calculated across all the
ResourceRecord elements over all referenced ResourceRecordSets and applies to both CREATE and
DELETE actions.

For more information about making changes to resource record sets, see Making Changes to Your
Resource Record Sets in the Amazon Route 53 Developer Guide.

Requests

Syntax

POST /2010-10-01/hostedzone/Z1PA6795UKMFR9/rrset HTTP/1.1
<?xml version="1.0" encoding="UTF-8"?>
<ChangeResourceRecordSetsRequest xmlns="https://route53.amazonaws.com/doc/2010-
10-01/">
   <ChangeBatch>
      <Comment>

This change batch creates an A record for www.example.com. and changes 
the A record for foo.example.com. from 192.0.2.3 to 192.0.2.1.
      </Comment>
      <Changes>
         <Change>
            <Action>CREATE</Action>
            <ResourceRecordSet>
               <Name>www.example.com.</Name>
               <Type>A</Type>
               <TTL>300</TTL>
               <ResourceRecords>
                  <ResourceRecord>
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                     <Value>192.0.2.1</Value>
                  </ResourceRecord>
               </ResourceRecords>
            </ResourceRecordSet>
         </Change>
         <Change>
            <Action>DELETE</Action>
            <ResourceRecordSet>
               <Name>foo.example.com.</Name>
               <Type>A</Type>
               <TTL>600</TTL>
               <ResourceRecords>
                  <ResourceRecord>
                     <Value>192.0.2.3</Value>
                  </ResourceRecord>
               </ResourceRecords>
            </ResourceRecordSet>
         </Change>
         <Change>
            <Action>CREATE</Action>
            <ResourceRecordSet>
               <Name>foo.example.com.</Name>
               <Type>A</Type>
               <TTL>600</TTL>
               <ResourceRecords>
                  <ResourceRecord>
                     <Value>192.0.2.1</Value>
                  </ResourceRecord>
               </ResourceRecords>
            </ResourceRecordSet>
         </Change>
      </Changes>
   </ChangeBatch>
</ChangeResourceRecordSetsRequest>

Headers
The request must include the headers required in all Amazon Route 53 requests. For more information,
see Common Headers (p. 38).

Parameters
The request must contain the hosted zone ID. Amazon Route 53 returns the hosted zone ID in the
HostedZone element as part of the CreateHostedZoneResponse or ListHostedZonesResponse.
For more information, see POST CreateHostedZone (p. 3) or GET ListHostedZones (p. 16).

Elements

RequiredDescriptionName

YesA complex type that contains change information for the
resource record set.

Type: Complex

Default: None

Children: ChangeBatch

ChangeResourceRecord
SetsRequest
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RequiredDescriptionName

YesThe information for a change request.

Type: Complex

Default: None

Children: Comment, Changes

ChangeBatch

OptionalAny comments you want to include about the change.

Type: String

Default: None

Constraints: Maximum 256 characters

Parent: ChangeBatch

Comment

YesInformation about the changes to make to the record sets.

Type: Complex

Default: None

Parent: ChangeBatch

Children: Change

Changes

YesThe information for each individual change.

Type: Complex

Default: None

Parent: Changes

Children: Action, ResourceRecordSet

Change

YesThe action to perform.

Type: String

Default: None

Valid Values: CREATE | DELETE

Parent: member

Action

YesInformation about the resource record set to create or
delete.

Type: Complex

Default: None

Parent: member

Children: Name, Type, TTL, ResourceRecords

ResourceRecordSet

YesThe name you wish to perform the action on.

This must be a fully-specified name, ending with a final
period as the last label indication. If you omit the final
period, Amazon Route 53 assumes the name is relative
to the root.

Type: String

Default: None

Parent: ResourceRecordSet

Name
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RequiredDescriptionName

YesThe DNS record type. For information about different
record types and how data is encoded for them, see
Appendix A: Domain Name and Resource Record
Formats in the Amazon Route 53 Developer Guide.

Type: String

Default: None

Valid Values: A | AAAA | CNAME | MX | NS | PTR | SOA
| SPF | SRV | TXT

Parent: ResourceRecordSet

Type

YesThe resource record cache time to live (TTL), in seconds.

Type: Integer

Default: None

Parent: ResourceRecordSet

TTL

YesInformation about the resource records to act upon.

Type: Complex

Default: None

Parent: ResourceRecordSet

Children: ResourceRecord

ResourceRecords

YesInformation specific to the resource record.

Type: Complex

Default: None

Parent: ResourceRecords

Children: Value

ResourceRecord

YesThe current or new DNS record value, not to exceed 4,000
characters. In the case of a DELETE action, if the current
value does not match the actual value, an error is
returned. For descriptions about how to format Value for
different record types, see Appendix A: Domain Name
and Resource Record Formats in the Amazon Route 53
Developer Guide.

Type: String

Default: None

Parent: ResourceRecord

Value

Responses

Syntax

HTTP/1.1 200 OK
<?xml version="1.0" encoding="UTF-8"?>
<ChangeResourceRecordSetsResponse xmlns="https://route53.amazonaws.com/doc/2010-
10-01/">
   <ChangeInfo>
      <Id>/change/C1PA6795UKMFR9</Id>
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      <Status>PENDING</Status>
      <SubmittedAt>2010-09-10T01:36:41.958Z</SubmittedAt>
   </ChangeInfo>
</ChangeResourceRecordSetsResponse>

Headers
The response will include the headers in all Amazon Route 53 responses. For more information, see
Common Headers (p. 38).

Elements

DescriptionName

A complex type containing the response information for the request.
This element contains the hosted zone ID parameter.

Type: Complex

Children: ChangeInfo

ChangeResourceRecord
SetsResponse

A complex type that describes change information about changes made
to your hosted zone.

This element contains an ID that you use when performing a GetChange
action to get detailed information about the change.

Type: Complex

Children: Id, Status, SubmittedAt

ChangeInfo

The ID of the request. Use this ID to track when the change has
completed across all Amazon Route 53 DNS servers.

Type: String

Parent: ChangeInfo

Id

The current state of the hosted zone.PENDING indicates that this request
has not yet been applied to all Amazon Route 53 DNS servers.

Type: String

Valid Values: PENDING | INSYNC

Parent: ChangeInfo

Status

The date and time the change was made.

Type: String with date in the format YYYY-MM-DDThh:mm:ssZ, as
specified in the ISO 8601 standard (for example, 2009-11-19T19:37:58Z)

Parent: ChangeInfo

SubmittedAt

Errors
The following table lists the errors returned for this action.

DescriptionName

The input is not valid.InvalidInput
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DescriptionName

This exception contains a list of messages that might contain one or
more error messages. Each error message indicates one error in the
change batch. For more information, see Example InvalidChangeBatch
Errors (p. 28).

InvalidChangeBatch

Examples

Example Request
This example creates an A record for www.example.com and changes the A record for foo.example.com
from 192.0.2.3 to 192.0.2.1.

POST /2010-10-01/hostedzone/Z1PA6795UKMFR9/rrset HTTP/1.1
<?xml version="1.0" encoding="UTF-8"?>
<ChangeResourceRecordSetsRequest xmlns="https://route53.amazonaws.com/doc/2010-
10-01/">
   <ChangeBatch>
      <Comment>
      This change batch creates a TXT record for www.example.com.,
      and changes the A record for foo.example.com. from 192.0.2.3 to 192.0.2.1.

      </Comment>
      <Changes>
         <Change>
            <Action>CREATE</Action>
            <ResourceRecordSet>
               <Name>www.example.com.</Name>
               <Type>TXT</Type>
               <TTL>600</TTL>
               <ResourceRecords>
                  <ResourceRecord>
                     <Value>"item 1" "item 2" "item 3"</Value>
                  </ResourceRecord>
               </ResourceRecords>
            </ResourceRecordSet>
         </Change>
         <Change>
            <Action>DELETE</Action>
            <ResourceRecordSet>
               <Name>foo.example.com.</Name>
               <Type>A</Type>
               <TTL>600</TTL>
               <ResourceRecords>
                  <ResourceRecord>
                     <Value>192.0.2.3</Value>
                  </ResourceRecord>
               </ResourceRecords>
            </ResourceRecordSet>
         </Change>
         <Change>
            <Action>CREATE</Action>
            <ResourceRecordSet>
               <Name>foo.example.com.</Name>
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               <Type>A</Type>
               <TTL>600</TTL>
               <ResourceRecords>
                  <ResourceRecord>
                     <Value>192.0.2.1</Value>
                  </ResourceRecord>
               </ResourceRecords>
            </ResourceRecordSet>
         </Change>
      </Changes>
   </ChangeBatch>
</ChangeResourceRecordSetsRequest>

Example Response
This is an example response to the request in the previous example.

HTTP/1.1 200 OK
<?xml version="1.0" encoding="UTF-8"?>
<ChangeResourceRecordSetsResponse xmlns="https://route53.amazonaws.com/doc/2010-
10-01/">
   <ChangeInfo>
      <Id>/change/C2682N5HXP0BZ4</Id>
      <Status>PENDING</Status>
      <SubmittedAt>2010-09-10T01:36:41.958Z</SubmittedAt>
   </ChangeInfo>
</ChangeResourceRecordSetsResponse>

Example InvalidChangeBatch Errors
The InvalidChangeBatch error contains a list of messages that contain zero, one or more error
messages. This section describes InvalidChangeBatch and some of the errors it might return.

Note

Amazon Route 53 locates as many errors as possible, but some errors can only be detected
after other errors are fixed. As a result, you might need to repeat your request to locate all the
errors.
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Example 1

If you already have a resource record set called duplicate.example.com. with type A records, and
you try to create the same resource record set again, you receive the following InvalidChangeBatch
exception.

HTTP/1.1 400 Bad Request
<?xml version="1.0"?>
<InvalidChangeBatch xmlns="https://route53.amazonaws.com/doc/2010-10-01/">
   <Messages>
      <Message>
      Tried to create resource record set duplicate.example.com. type A,
      but it already exists
      </Message>
   </Messages>
</InvalidChangeBatch>

Example 2

If you don't have the resource record set noexist.example.com. with type A records, but you try to
delete it, you will get the following InvalidChangeBatch error.

HTTP/1.1 400 Bad Request
<?xml version="1.0"?>
<InvalidChangeBatch xmlns="https://route53.amazonaws.com/doc/2010-10-01/">
   <Messages>
      <Message>
      Tried to delete resource record set noexist.example.com. type A,
      but it was not found
      </Message>
   </Messages>
</InvalidChangeBatch>

Example 3

If you put the above two changes into a single change batch and you call ChangeResourceRecordSets,
you receive this error.

HTTP/1.1 400 Bad Request
<?xml version="1.0"?>
<InvalidChangeBatch xmlns="https://route53.amazonaws.com/doc/2010-10-01/">
   <Messages>
      <Message>
      Tried to create resource record set duplicate.example.com. type A,
      but it already exists
      </Message>
      <Message>
      Tried to delete resource record set noexist.example.com. type A,
      but it was not found
      </Message>
   </Messages>
</InvalidChangeBatch>
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GET ListResourceRecordSets

Description
To list your resource record sets, send a GET request to the 2010-10-01/hostedzone/<hosted zone
ID>/rrset resource.

The action retrieves a specified number of resource record sets in order, beginning at a position specified
by the Name and Type elements. The action sorts results first by DNS name (with the labels reversed,
for example com.amazon.www), and second by the record type.

You can use the Name and Type elements to adjust the beginning position of the list of resource record
sets returned. For more information on using this action to retrieve information about your resource record
sets, see Listing Your Resource Record Sets in the Amazon Route 53 Developer Guide.

Note

This action returns the most current version of the records.This includes records that are PENDING,
and that are not yet available on all Amazon Route 53 DNS servers.

Requests

Syntax

GET /2010-10-01/hostedzone/<hosted zone ID>/rrset?type=NS&name=example.com&max 
items=10

Headers
The request must include the headers required in all Amazon Route 53 requests. For more information,
see Common Headers (p. 38).

Parameters

RequiredDescriptionName

YesThe ID of the hosted zone containing the resource records
sets to be retrieved.

Type: String

Default: None

<Hosted Zone ID>
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RequiredDescriptionName

NoThe type of resource record set to begin the record listing
from. For information about different record types and
how data is encoded for them, see Appendix A: Domain
Name and Resource Record Formats in the Amazon
Route 53 Developer Guide.

Type: String

Default: None

Valid Values: A | AAAA | CNAME | MX | NS | PTR | SOA
| SPF | SRV | TXT

Constraint: Specifying Type without specifying Name
returns an InvalidInput error.

Type

No.The first name in the lexicographic ordering of domain
names to be retrieved in the response to the
ListResourceRecordSets request.

Type: String

Default: None

Name

NoThe maximum number of records you want in the
response body.

Type: String

Default: 100

Constraint: maximum value is 100

maxitems

Responses

Syntax

HTTP/1.1 200 OK
<?xml version="1.0" encoding="UTF-8"?>
<ListResourceRecordSetsResponse xmlns="https://route53.amazonaws.com/doc/2010-
10-01/">
   <ResourceRecordSets>
      <ResourceRecordSet>
         <Name>example.com.</Name>
         <Type>SOA</Type>
         <TTL>900</TTL>
         <ResourceRecords>
            <ResourceRecord>
               <Value>ns-500.awsdns-11.net. hostmaster.awsdns.com. 1 7200 900 
1209600 86400</Value>
            </ResourceRecord>
         </ResourceRecords>
      </ResourceRecordSet>
   </ResourceRecordSets>
   <IsTruncated>true</IsTruncated>
   <MaxItems>1</MaxItems>
   <NextRecordName>testdoc2.example.com</NextRecordName>
   <NextRecordType>NS</NextRecordType>
<ListResourceRecordSetsResponse>
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Headers
The response will include the headers in all Amazon Route 53 responses. For more information, see
Common Headers (p. 38).

Elements

DescriptionName

A complex type that contains list information for the resource record set.

Type: Complex

Children: ResourceRecordSets, IsTruncated, MaxItems,
NextRecordName, NextRecordType

ListResourceRecord
SetsResponse

Information about multiple resource record sets.

Type: Complex

Parent: ListResourceRecordSetsResponse

Children: ResourceRecordSet

ResourceRecordSets

Information about multiple resource records.

Type: Complex

Parent: ResourceRecordSets

Children: Name, Type, TTL, ResourceRecords

ResourceRecordSet

The name of the domain. This is a fully-specified domain, ending with
a period as the last label indication. If you omit the final period, Amazon
Route 53 assumes the domain is relative to the root.

Type: String

Parent: ResourceRecordSet

Name

The resource record set type the record listing begins from. For
information about different record types and how data is encoded for
them, see Appendix A: Domain Name and Resource Record Formats
in the Amazon Route 53 Developer Guide.

Type: String

Valid Values: A | AAAA | CNAME | MX | NS | PTR | SOA | SPF | SRV |
TXT

Parent: ResourceRecordSet

Type

The resource record cache time to live (TTL), in seconds.

Type: Integer

Parent: ResourceRecordSet

TTL

Information about the resource records.

Type: Complex

Parent: ResourceRecordSet

Children: ResourceRecord

ResourceRecords

Information about the resource record.

Type: Complex

Parent: ResourceRecords

Children: Value

ResourceRecord
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DescriptionName

Content for the resource record.

Type: String

Parent: ResourceRecord

Value

A flag that indicates whether more resource record sets remain to be
listed. If your results were truncated, you can make a follow-up pagination
request by using the NextRecordName request.

Type: String

Valid Values: true | false

Parent: ListResourceRecordSetsResponse

IsTruncated

The maximum number of records you requested.

Type: String representation of a number, not to exceed 100

Parent: ListResourceRecordSetsResponse

MaxItems

If the results were truncated, the name of the next record in the list.

This element is present only if IsTruncated is true.

Type: String

Parent: ListResourceRecordSetsResponse

NextRecordName

If the results were truncated, the type of the next record in the list.

This element is present only if IsTruncated is true.

Type: String

Parent: ListResourceRecordSetsResponse

NextRecordType

Errors
The following table lists the error returned for this action.

DescriptionName

The input is not valid.InvalidInput

Example 1
This example returns a single known record set by setting MaxItems to 1.

Example Request

GET /2010-10-01/hostedzone/Z1PA6795UKMFR9/rrset?maxitems=1

Example Response

HTTP/1.1 200 OK
<?xml version="1.0" encoding="UTF-8"?>
<ListResourceRecordSetsResponse xmlns="https://route53.amazonaws.com/doc/2010-
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10-01/">
   <ResourceRecordSets>
      <ResourceRecordSet>
         <Name>example.com.</Name>
         <Type>SOA</Type>
         <TTL>900</TTL>
         <ResourceRecords>
            <ResourceRecord>
               <Value>ns-500.awsdns-11.net. hostmaster.awsdns.com. 1 7200 900 
1209600 86400</Value>
            </ResourceRecord>
         </ResourceRecords>
      </ResourceRecordSet>
   </ResourceRecordSets>
   <IsTruncated>true</IsTruncated>
   <MaxItems>1</MaxItems>
   <NextRecordName>testdoc2.example.com</NextRecordName>
   <NextRecordType>NS</NextRecordType>
</ListResourceRecordSetsResponse>

Example 2
This example returns a list of record sets by specifying Name and Type, and setting MaxItems to 10.

Example Request

GET /2010-10-01/hostedzone/Z1PA6795UKMFR9/rrset?type=NS&name=example.com&max 
items=10

Example Response

HTTP/1.1 200 OK
<?xml version="1.0" encoding="UTF-8"?>
<ListResourceRecordSetsResponse xmlns="https://route53.amazonaws.com/doc/2010-
10-01/">
   <ResourceRecordSets>
      <ResourceRecordSet>
         <Name>example.com.</Name>
         <Type>NS</Type>
         <TTL>172800</TTL>
         <ResourceRecords>
            <ResourceRecord>
               <Value>ns-01.awsdns-00.com.</Value>
            </ResourceRecord>
            <ResourceRecord>
               <Value>ns-500.awsdns-11.net.</Value>
            </ResourceRecord>
            <ResourceRecord>
               <Value>ns-1112.awsdns-31.org.</Value>
            </ResourceRecord>
            <ResourceRecord>
               <Value>ns-1600.awsdns-27.co.uk.</Value>
            </ResourceRecord>
         </ResourceRecords>
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      </ResourceRecordSet>
   </ResourceRecordSets>
   <IsTruncated>false</IsTruncated>
   <MaxItems>10</MaxItems>
</ListResourceRecordSetsResponse>

API Version 2010-10-01
35

Amazon Route 53 API Reference
Example 2



GET GetChange

Description
This action returns the current state of a change request. The state of a change is either PENDING or
INSYNC. A status of PENDING means the change is not yet propagated over the authoritative Amazon
Route 53 DNS servers. A status of INSYNC means the change is propagated.The initial value of a change
request is PENDING. For more information about getting the status of a change request see Checking
the Status of Your Change in the Amazon Route 53 Developer Guide.

To retrieve status information about a change, send a GET request to the 2010-10-01/change/<change
ID> resource.

Requests

Syntax

GET /2010-10-01/change/C2682N5HXP0BZ4

Headers
The request must include the headers required in all Amazon Route 53 requests. For more information,
see Common Headers (p. 38).

Parameters
The request must contain the change ID. The change ID is found in the ChangeInfo element of any
response that creates or modifies a hosted zone.

Responses

Syntax

HTTP/1.1 200 OK
<?xml version="1.0" encoding="UTF-8"?>
<GetChangeResponse xmlns="https://route53.amazonaws.com/doc/2010-10-01/">
  <ChangeInfo>
     <Id>/change/C2682N5HXP0BZ4</Id>
     <Status>INSYNC</Status>
     <SubmittedAt>2010-09-10T01:36:41.958Z</SubmittedAt>
   </ChangeInfo>
</GetChangeResponse>

Headers
The response will include the headers in all Amazon Route 53 responses. For more information, see
Common Headers (p. 38).
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Errors
This action returns the following error.

DescriptionName

The input is not valid.InvalidInput

Examples

Request
GET /2010-10-01/change/C2682N5HXP0BZ4

Response

HTTP/1.1 200 OK
<?xml version="1.0" encoding="UTF-8"?>
<GetChangeResponse xmlns="https://route53.amazonaws.com/doc/2010-10-01/">
   <ChangeInfo>
      <Id>/change/C2682N5HXP0BZ4</Id>
      <Status>INSYNC</Status>
      <SubmittedAt>2010-09-10T01:36:41.958Z</SubmittedAt>
   </ChangeInfo>
</GetChangeResponse>
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Common Headers

This section lists the common HTTP headers that Amazon Route 53 uses in REST requests.

Request Headers
RequiredDescriptionHeader Name

YesThe information required for request authentication.
For more information, go to Authenticating REST
Requests in the Amazon Route 53 Developer Guide.

X-Amzn-Authorization

ConditionalLength of the message (without the headers) according
to the RFC 2616 specification.

Condition: Required if the request body itself contains
information (most toolkits add this header
automatically).

Content-Length

ConditionalThe content type of the resource. Example:
text/plain.

Condition: Required for POST and PUT requests.

Content-Type

ConditionalThe date used to create the signature contained in the
X-Amzn-Authorization header.

Condition: Required unless you provide the
x-amz-date header. For more information about the
request time stamp, and for information on formatting
dates, go to REST Requests in the Amazon Route 53
Developer Guide).

Date

ConditionalThe host being requested. The value must be
route53.amazonaws.com.

Condition: Required for HTTP 1.1 (most toolkits add
this header automatically)

Host
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RequiredDescriptionHeader Name

ConditionalThe date used to create the signature contained in the
X-Amzn-Authorization header.

Condition: Required if you do not provide the Date
header. If both this header and the Date header are
present, the Date header is ignored. For more
information about the request time stamp, and for
information on formatting date, go to REST Requests
in the Amazon Route 53 Developer Guide).

x-amz-date

Request ID Response Header
Each response contains a request ID that you can use if you need to troubleshoot a request with Amazon
Route 53. The ID is contained in an HTTP header called x-amz-request-id. An example of a request
ID is 647cd254-e0d1-44a9-af61-1d6d86ea6b77.
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Common Errors

The following table lists the errors that all Amazon Route 53 actions return. Errors specific to a particular
action are listed in the topic for that action. For information about the format of error responses, go to
REST Responses in the Amazon Route 53 Developer Guide.

HTTP Status CodeDescriptionError

403Access denied.AccessDenied

400The XML document you provided was
well-formed and valid, but not appropriate
for this operation.

InappropriateXML

500We encountered an internal error. Please try
again.

InternalError

400The action specified is not valid.InvalidAction

400<Parameter name and problem>InvalidArgument

400There was an error in the body of your HTTP
request.

InvalidHTTPRequest

403The request signature Amazon Route 53
calculated does not match the signature you
provided. Check your AWS Secret Access
Key and signing method. Consult the service
documentation for details.

InvalidSignature

400Could not parse the specified URI.InvalidURI

400The XML you provided was not well-formed
or did not validate against our published
schema.

MalformedXML
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HTTP Status CodeDescriptionError

403The HTTP authorization header is bad, use
the format:

AWS3-HTTPS AWSAccessKeyId=Access 
Key, Algorithm=ALGORITHM,Signa 
ture=Base64( Algorithm((ValueOfD 
ateHeader), SigningKey) )

MissingAuthenticationToken

400Authorized request must have a date or
x-amz-date header.

MissingRequiredParameter

501Not implemented.NotImplemented

403The AWS Access Key ID needs a
subscription for the service.

OptInRequired

400Request has expired. Time stamp date is
<the value of the Date or x-amz-date header
you submitted in the request>.

RequestExpired

403The security token included in the request is
invalid.

UnrecognizedClient
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Document Conventions

This section lists the common typographical and symbol use conventions for AWS technical publications.

Typographical Conventions
This section describes common typographical use conventions.

Description/ExampleConvention

A call-out is a number in the body text to give you a visual reference. The
reference point is for further discussion elsewhere.

You can use this resource regularly.

Call-outs

Inline code samples (including XML) and commands are identified with a
special font.

You can use the command java -version.

Code in text

Blocks of sample code are set apart from the body and marked accordingly.

# ls -l /var/www/html/index.html
-rw-rw-r--  1 root root 1872 Jun 21 09:33 
/var/www/html/index.html
# date
Wed Jun 21 09:33:42 EDT 2006

Code blocks

Unusual or important words and phrases are marked with a special font.

You must sign up for an account before you can use the service.

Emphasis

References to a section in the same document are marked.

See Document Conventions (p. 42).

Internal cross references
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Description/ExampleConvention

A special font is used for expressions that are important to identify, but are
not code.

If the value is null, the returned response will be false.

Logical values,
constants, and regular
expressions, abstracta

Named AWS products and features are identified on first use.

Create an Amazon Machine Image (AMI).

Product and feature
names

In-text references to operations.

Use the GetHITResponse operation.

Operations

In-text references to parameters.

The operation accepts the parameter AccountID.

Parameters

In-text references to responses.

A container for one CollectionParent and one or more
CollectionItems.

Response elements

References to other AWS publications. If the reference is hyperlinked, it is
also underscored.

For detailed conceptual information, see the Amazon Mechanical Turk
Developer Guide.

Technical publication
references

A special font marks text that the user types.

At the password prompt, type MyPassword.

User entered values

Denotes named items on the UI for easy identification.

On the File menu, click Properties.

User interface controls
and labels

When you see this style, you must change the value of the content when you
copy the text of a syntax sample to a command line.

% ec2-register <your-s3-bucket>/image.manifest

See also the following symbol convention.

Variables
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Symbol Conventions
This section describes the common use of symbols.

Description/ExampleSymbolConvention

Within a code description, bar separators denote options from
which one must be chosen.

% data = hdfread (start | stride | edge)

(Parentheses | and
| vertical | bars)

Mutually
exclusive
parameters

Within a code description, square brackets denote completely
optional commands or parameters.

% sed [-n, -quiet]

Use square brackets in XML examples to differentiate them from
tags.

<CustomerId>[ID]</CustomerId>

[square brackets]Optional
parameters

XML variable
text

Within a code sample, arrow brackets denote a variable that
must be replaced with a valid value.

% ec2-register <your-s3-bucket>/image.manifest

<arrow brackets>Variables
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